
 

 
 Page 1 of 13 

Tax Technical Update - December 2020 
 
 
 
 

CCH Learning: 

Hi everyone. Welcome to today's webinar regarding the Best of Microsoft Outlook. I'm Alison Wood from Wolters 
Kluwer's CCH Learning. I'll be your moderator for today. 

Just a few quick pointers before we get started. If you're having sound problems, and hopefully you can still hear 
this, please toggle between audio and phone. Or hopefully, you can see on the screen here, just in that audio 
section. In terms of the PowerPoint, that will be sent out after the session. You can also access it now in the 
handout section. In terms of your e-learning recording, you'll receive an email letting you know when that is 
ready to be viewed. 

You can ask questions at any point during the session today. Simply type them in the questions box. I will collate 
these questions, and ask them at the Q&A at the end of today's presentation. 

CCH Learning also offers a subscription service, which many people have termed Netflix for professionals. It 
provides members with access to our entire library of recordings as well as live webinars, for a very competitive 
flat fee. That's for over 500 hours of content. For CPD purposes, your viewing is logged automatically. 

Your presenter today is Waqar Awan, applications trainer from Lumify Work. Coming from the domain of data 
analytics, Waqar is an engaging trainer. He is able to offer a wide range of Microsoft end user and project 
management training. He has extensive experience delivering training in a variety of formats including classroom, 
video conference, webinar, and one-to-one sessions. 

I will now pass you over to Waqar to commence today's presentation. 

Waqar Awan: 

Thank you very much, Alison. Yeah. My screen has been shared. Fantastic. Hello everybody. My name is Waqar. 
I'm going to be teaching you few tips and tricks, and showing you some features of Outlook. 

We are going to start by just looking at the UI, which is the user interface. Then we're going to move towards few 
tips and tricks regarding managing emails, arranging your emails the way they're displayed, grouping your emails. 
We'd also look into changing layouts of your Outlook user interface. We'd also tweak some current view settings. 
We'd also look into Outlook views. Outlook has got three views at the moment. They've got Calendar view, then 
we've got To-do List view, and then we have got the Mail view. We're going to be looking into all three of them. 
There are few more, but these are the most important ones we're going to be looking into. 

We'd also look going to Calendar, creating invites and appointments. What's the difference between 
appointments and invites? How does appointment change into invites? We'll look into those bits and bobs as 
well. 

I'm going on the next slide. This slide showcase the UI, the user interface. We're going to look into a bit of detail 
as to what are views and what are tabs, how to deal with Automatic Replies, how to set Automatic Replies, how 
to manage alerts, and rules, how to create rules and manage them, of course. 
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Okay. I'm going to go ahead and share my screen with Outlook. There it is. Thank you very much. Just bear with 
me for a second. There we go. 

Voila. Thank you very much. Okay. When you open Outlook, you're greeted with the screen. Now, what do we 
have in the screen is simply on the left-hand side, we've got various views. At the moment, we are in Mail view. 
We also have Calendar view, and we have got People view, which is slightly beyond the scope of this course. But 
we are going to be looking into Task view. 

The three views, which I mentioned earlier, we are going to be looking into is Mail view. Then we are going to be 
looking into Calendar view. Then we are going to be looking into To-do list view. Also, be aware that if we are on 
the Mail view, we have got tabs on the top. These are referred as tabs. When we click on each tab, you've got 
these ribbons appear at the bottom. In these ribbons you have got functions. These functions are grouped. 

If we are in Home tab, you have the lead functions grouped together. It's also really good for communicating with 
your colleague. If you want to specify as to where a specific function sits, you can mention that, "Hey, please go to 
View tab, then go to Layout group, click on Folder Pane, and select Minimise or keep it Normal." Or, you can 
change Reading Pane. Yeah, you can communicate really well if you go and follow the same technique like I 
mentioned. 

If you are in the Home tab, we've got the list of functions over here. Most importantly, what we do as soon as you 
move to different tabs, the functionalities remains the same if you are in a specific view. But if you move to a 
different view, the functionalities which are sitting in the tabs would also change. Though the number of tabs 
remain the same. You'll always have Home, Send/Receive, Folder, View and Help. But the functionality sitting in a 
specific view would be different. 

Okay. Let's start on the top left-hand side of the screen or UI. We have got over here a Quick Access Toolbar. At 
the moment, I haven't allocated any function to this Quick Access Toolbar. But I like you guys to think about 
functions which you use quite often. It's a bit hard or cumbersome to go to a specific tab, and find that function 
every time you want to use it. 

What you can do is to pin that function right on the top to customise your toolbar. How do you do that? For you 
to pin a function, you can click on this dropdown arrow. Once you click this dropdown arrow, you see a lot of 
functions which are sitting here by default. If you want to pin Reply function in your Quick Access Toolbar, you 
can see that Reply function goes on the top. 

If you want to pin, let's say, Empty Deleted Items, if you want to pin this function on Quick Access Toolbar, you 
can click on that, and it'll go on the top. You can go ahead pin as many functions as you want. They'll show on the 
top. If you want to get rid of them, you can just untick them by just selecting the one you have pinned, so you can 
get rid of them. 

Now, for example, if you are using a function, and that function doesn't sit here, and you cannot find it here, you 
can still find that function by going to More Commands. Now, if you could click on More Commands here, you are 
greeted with this dialogue box. This dialogue box comes in many places. Meaning that this is a dialogue box which 
has got Outlook options. Most of the options you want to tweak for Outlook, you are greeted with this dialogue 
box. 

Sometimes you'll see a dialogue box which would be on General tab. Sometimes you'll see it in the Mail. It's been 
highlighted. The tab have been highlighted. At the moment, since we want to tweak the settings of Quick Access 
Toolbar, it is sitting in Quick Access Toolbar. All right. For example, if I want to add a function from the folder tab, 
and the function is add to the favourite, to my Quick Access Toolbar, I can go ahead and click on this dropdown 



 

 
 Page 3 of 13 

arrow. Then select the tab where the function is sitting. The function is sitting in the Folder tab. I can go down. 
You can see the Folder tab is sitting here. 

If I click on Folder tab, all the functions which are in Folder tab are listed here. I can pick the one I want. Like I 
mentioned before, I was looking for Add to the Favourites. I can click on that function. Then I can add to my Quick 
Access Toolbar. 

Currently, I've got two functions sitting in my Quick Access Toolbar. The first one is Empty Deleted Items. The 
second one is Forward. Now, I've added the third one, which is Add to Favourites. Now, this has been added, but 
you won't be able to see that function unless until you press OK, and that function's been added. 

Now, if you use that function quite often. You want to add it to your Quick Access Toolbar. It doesn't sit in your 
default functions, you can always go to More Commands and find the function there. But if you add the function 
once, it does become part of your default list of functions. Like we didn't have Empty Deleted Items before, now 
we do. I want to get rid of it, just in case, we can click on that. It goes away. 

Okay. That is your Quick Access Toolbar. Take notes of the functions which you use quite often. Then go find 
those functions where they are sitting, in which tabs, and add them on your Quick Access Toolbar. That would 
save you a lot of time. 

You can go ahead and use the search bar as well if you want to search a function, or the action. If you want to 
look into an email sent by a person, you can always select. For example, this is a dummy email address given to 
one of the students. The person may have flick me some emails. I want to select all the emails that this person 
has sent. I can see it's showing me in my dropdown list. I can click on it. You can see all the emails that has been 
sent by this person. I can add my filtering as well. If I want to add further aspects of the filtering, I would be able 
to add it there as well. 

Let's go to search again. Then we were looking into the student emails that this person sent across. Now, please 
be aware that when you are searching something, on the left-hand side, you have an option of specifying the 
mailbox you want to search in. At the moment, I am looking at my current mailbox. If I want to search in all the 
mailboxes, then I would click on that. I'm not going to select all the mailbox, because the mailbox which I have got 
above here, this is my work email, current work email. I don't want to search it there. 

However, in your instance, if you've got multiple mailboxes, you can select All Mailboxes. It will search in all the 
mailboxes. If you want to get rid of the search, just click on that. It'll go away. Cool. I'll press Close over here. 

If you go further on the right-hand side, you are able to see the email address you are currently using. You can 
sign out from here. You can add another email you want to use for your Microsoft 365 product. This is essentially 
for your Microsoft 365 product. On the left-hand side ... Apologies, let's go on this side here. If you're using your 
Microsoft 365 account here, and if you want to add multiple mails, you can add as many emails as you want. 
There's no restrictions to that. Cool. 

Then we have got our menu here where we can close the programme, resize or minimise. This is also a function 
which has got a sign of bell. It shows all the notifications you may have. If you have more notifications, you'll see a 
letter on the top, a numerical number 1, 2, 3 as to how many notifications you have. 

At the bottom part, we have got on the bottom left, it shows 56 items. Now, in this mailbox which I have 
highlighted, this one here, I've got Inbox. In Inbox, I have got 56 items. Out of those 56 items, I have got 21 
unread emails, and I've got one reminder. It's a good practise to click on your folder. It could be Inbox or any 
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other folder to see how many items are in there. You can always select one of the email, and press control A to 
select all the items. Do the same thing by showing how many items you have selected. 

At the bottom right-hand side, you are able to see a function that says, All folders are up-to-date. It's always nice 
to check once you open your Outlook, that if you're still connected to the email or internet. Sometimes it takes a 
bit of time for your Outlook to load all the emails. You can always look at the synchronisation status right at the 
bottom. You can also see if it is connected to Microsoft Exchange. 

But what is Microsoft Exchange? Microsoft Exchange is a platform that allows us to integrate various email 
addresses. This is the go-to platform that allows us to add more email addresses to our Outlook. We can change 
the display settings if there is a need to it, but most of the time, there's no need for changing the display settings. 

At the bottom right-hand side, we have called zoom in and zoom out. We can go and press this positive sign to 
zoom in and zoom out, which is a bit cumbersome. What I like to do is press control on my keyboard, scroll up, 
and scroll down. Scroll up is zoom in, scroll down is zoom out. Okay, cool. 

Let's have a look at some of the key functionalities sitting in these tabs. The first one I want to focus on is File tab. 
Let's go and click on File. As soon as I click on File, the first tab that opens up is Info. At the moment, I am getting 
account information. The account which I am connected to is waqar.awan. There's a dummy on Microsoft 
platform. I'm using Microsoft Exchange. 

Now, just in case if I want to, I've got two accounts here already. One is my work, one is a dummy account, and if I 
want to add my home account just in case, in your case it could be another work account, you can always go 
ahead and click on Add Account. 

What would happen when you click on Add Account? It would search for the accounts. It would ask you to put 
your email address down. It takes a little bit of time, but when it starts working, all you need to do is to put the 
email address. Then basically press Okay, Okay, and Okay. It'll add up the account you want to add, essentially. 
Okay, cool. 

Right. Let's go back. We were in the File tab. If I want to change some account settings, I can do it from here. At 
this stage, it is just slightly beyond the scope of the course. But one function which I really find useful is Delegate 
Access. Delegate Access is a function which you can give other people, like basically your colleagues, permission 
to receive and respond emails on your behalf. Make sure you have picked up the right account you want to 
delegate access to. Then go to Account Settings. Then you click on Delegate Access. 

Please bear in mind that this function takes a lot of time. At the moment, I have delegated access to one of my 
students. If I want to add another person or a colleague in here, I can go click on Add. As soon as I press Add, I can 
see all the people or staff members working in my organisation. I can search for their names. Then all I have to do 
is press OK. I'm not going to press OK here because it's just going to take a bit of time. Like I mentioned before, 
delegating excess approval may take probably 50 seconds to get everything approved. We don't want to wait for 
that long. However, the process is very similar. Always get the permission first, and then you can add people to 
your delegate list. Let's cancel that. 

Another important feature which I see a lot of people using is Automatic Replies. This is an answer machine sort 
of a thing you have got set up. If you're on holiday, you're out of office, or you're attending a meeting, you can set 
your Automatic Replies. Just in case if somebody sends an email, that person gets a reply back straight away, with 
a specific message that you have added as a part of your replies. 
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Okay. How does this thing work? All right. Please make sure when you're setting your Automatic Replies, and if 
you have multiple accounts, make sure that you have selected the right account you want to set Automatic 
Replies to. Then what you do is click on Automatic Replies. A little dialogue box would appear here. 

Now by default, it is saying that, "Do not send Automatic Replies." But if we want to set it for sending Automatic 
Replies, we can select the second option here. Then we can also go ahead and specify the time we want to set 
Automatic Replies from, and to. Let's say our start time is Wednesday 31st of Jan, 2024, time 3:00 PM to 
Thursday, 1st of Feb, 3:00 PM. 

Then I have another option over here, which is inside the organisation and outside of the organisation. Now, 
inside of an organisation, if somebody is sending internally an email, that person may get a very detailed email 
that, "Look, I'm in Room 23. We are looking at budgetary statements. I won't be available till later in the evening." 
You can add a bit more detail. 

But for outside of the organisation, it would be slightly different generic message. That, "I'm unavailable at the 
moment. I'll respond back after 3:00 PM on Thursday." You can actually type the message here. "Hi there," et 
cetera. Then you can type the whole message here. You can actually format it as well. You can select the font size, 
the type and all the stuff you want to do. You can add bullet points, et cetera. You can really create that message 
in detail. 

Another thing which I think is slightly overlooked by some people is this little, cheeky button over here, which is 
Rules. Now, that really gives us the power to give specific Automatic Replies, if an email which is coming in meets 
a specific condition. Let's click on Rules. Then I get a little dialogue box that opens up here. This dialogue box says 
that, "These rules would be applied to incoming messages while you are outside of the office." 

At the moment, there is no condition that is applied. I can add a rule. I can say, "When a message arrives that 
meets the following conditions," I can say, if it is coming from a specific person or from a specific stakeholder, 
send to, if it has been sent to me directly, or I've been copied to it. I can specify that. 

I can also add the subject, and say, "Look, if somebody writes me an email asking about budgetary statement," 
then the automatic reply would go off. Then you can also specify the body message. What could be in body 
message that would start the automatic reply? Now, these are the conditions which are being checked as soon as 
the message or the email arrives, this box. 

This is the action that you are specifying it to perform. You can tell the system, "Hey, alert with an action." Do an 
action. An action could be, "Hey, notify me that, there is an important message," by playing a sound. Then you 
can specify the sound as well. You can tell the system what sound to play. You can test it and press OK. Make sure 
you test it all the time. Again, 99% of the time, everything works fine, but testing is always good. That you're sure 
that it is doing what it's supposed to. 

You can specify an alert. You can go ahead and delete. Replying to a meeting invite, for example, if you have sent 
a meeting invite to 500 people, and they're accepting it. You're getting the email back from 500 people. You can 
go ahead and specify that, if it says accepted or change in time from a specific email address, then you can go 
ahead and say, "Please delete it." That would automatically be deleted. 

You can move emails to a specific folder. If a folder you have created for weekly reports, somebody sends you a 
weekly report, and the subject is Weekly Report, you can say, "Could you please move it to a folder within this?" 
Because remember, I had two email addresses. I said, "Move it to the first email," which I've been using. Then 
move it to a folder. Obviously, I would need to create a folder first, which would be Weekly Reports, so I'm able to 
direct the email to that weekly folder. 
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Now, we've got a lot of options here. You can copy it. You can forward it. You can reply with a specific template. 
Now, if you're not really happy with all these options, you can always go click on Advanced. This would be really 
going in a bit too much detail, but you have advanced features in order to pick up the message features, and then 
reply accordingly. 

That is a part of Automatic Replies. Do take time out to set these Automatic Replies. It really are very helpful in 
communicating with your stakeholders. Takes away a lot of typing you may do at work on Outlook. Let's close 
that. 

Now, all the rules that you end up applying. Please be aware that Automatic Replies and the rules applied in 
Automatic Replies is one way where you apply rules. There are many other places you can go ahead and apply 
rules in Microsoft Outlook. One place where you can apply a rule is in the View tab. If you're in the View tab, then 
you go ahead and click on View Settings, you have got a Conditional Format right here, Conditional Format. 

What this does is this also allows us to define a rule and apply a condition to an email. By default, there are few 
rules that have the conditions that have been applied to a specific type of message. For example, if I have any 
unread messages, they're going to be always showing with this particular font. If I have unread group headers, 
they would be showing with this font. 

I have submitted, but not send the email, they would be showing with this font. I can go ahead and change it, I 
can change it. I can customise it. Say, "Look, if there is an email that's been submitted but it's not been sent, I 
want it to be bold and italic. I want it to be red so I can identify it." You can set it up. 

Then you see there's expired email rule, overdue email. This is the condition that applies to the message from 
other folders, et cetera. Then these are the default rules that have been applied. The one which I created earlier 
is a weekly status report. I can manually turn that rule on and off as per my liking. Earlier it was turned off, and 
we're just going to leave it off. 

How do we create a rule? One way of creating the rule earlier was going here, like I showed you, in Automatic 
Replies part. Automatic Replies and Rules at the bottom here. Another way which I wanted to show is just going 
in the View part here. View Settings, Conditional Formatting, and then adding a rule. 

Now, you can give the rule a name. Call it the Report. You can specify how it would show in your messages here. 
Then you can apply the condition here. Search for the keywords. Keywords, Weekly Report, that's it. Search it in 
the subject field only, subject field and message body. Then you can also specify. It's not compulsory that you 
specify these ones. As long as you have said, "Hey, search for the word which is Weekly Report in subject field or 
message body." Then we can press OK. 

Then every time that email comes in, I can go ahead and change the font to bold and let's say lime. Probably not 
the best colour because you can't see anything with this colour. Let's say blue. Okay, there we go. Any email 
which I am receiving that contains this condition, Weekly Report, would be highlighted in a blue colour. That's 
pretty cool. That's another place where you can add rules, in Conditional Formatting. Let's close this. 

Let's go back to the File tab we were looking at earlier. Imagine if you have added all the rules in this email 
address above. You want to tweak, activate, or deactivate the rules. You can always go to Manage Rules & Alerts. 
All the rules that you have created would be listed here. That not only allows you to manage your rules, but also 
you can delete a rule and add a new rule. If I want to add a new rule, I can go ahead and add it from here as well. 
That's a third way to add a rule. 
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This is a bit more comprehensive way to add rules. We have some rule templates, which is Rules Wizard. If you 
want to stay organised, there are few rules over here which you can use as a template. They're very easy to start 
using. Just press Next. Make sure you read through it. These are the rule instructions read through, and the rule 
instructions from there. Yeah, cool. 

I would suggest you to go ahead and create your Automatic Reply rules and also go ahead and create Conditional 
Formatting rules. Now, once you master that, then go ahead in this part. You can start using Rules Wizard. That 
will give you a good understanding before making a bit more complicated rules. Let's close this. 

If I want to change any settings of Microsoft Outlook, I can go ahead in Options. This dialogue box opens up. Like I 
mentioned earlier, that this is Outlook Options dialogue box. You see this many manifestations of this dialogue 
box. Earlier, we were looking at Quick Access Toolbar. Now, it's showing us the General tab. 

Let's have a look at the General tab. What do we have here? We've got a lot of options here, but the one I really 
want to focus is personalise a copy of your Office. You can change your username and change your initials from 
here. You can change your themes. At the moment, I've got a dark grey theme. If I turn it into white theme, it's 
going to give me a bit too much glare. If I'm working on Outlook for extended period of time, it's good practise to 
have it set as dark grey. How do you do that? Go to File, go to Options, go to General, and then Office Theme, 
dark grey. Press OK. Cool. 

While we are in File, and we are in Options, we also have an Option in Advanced. Let's go to Advanced part. Let's 
go further down. If we want to change our languages and stuff, we can go ahead and change it from this 
advanced feature over here. Specifically from this part, International options. That's another way for you to 
change the languages. Let's press OK. Cool. 

All right. I have covered this top here. Let's have a look at while we are in Mail View, I've opened up this email. If I 
intend to add additional mailboxes at the bottom, or folders, I can go ahead and essentially right-click, and create 
New Folder. Please be aware that a new folder, which I have created, this is in the hierarchy with Inbox being up. 
However, if I want to create a folder at the same hierarchy level as of Inbox, I would need to go to the mailbox 
over here, then right-click and then click on New Folder. Now, I'm at the same level of hierarchy. In this case, I'll 
call it Weekly Report. 

You can say, it's sitting at the same level of hierarchy. I can keep on populating this folder with emails. I can move 
my emails to this folder. How do I do that? Pretty easy. Select the email you want to move. Then when you right-
click it, you'd be surprised by the number of options you've got here. You have got Copy, Quick Print, Reply, Reply 
All, Forward, Mark as Read. 

You can specify a category. You can change the name of the category as well. For example, anything related with 
budget could be green, anything related with sales could be orange. You can specify. Follow Up, Assign Policy, and 
then you've got a lot of options here. What we are interested in is Move. Let's go. Move to Weekly Report. You 
can see that folder sitting on the top, Weekly Report, in the same email address. Let's click on that. 

As soon as I clicked on it, you can see Weekly Report is now showing 1, because that email has been moved. It's 
not the best idea to look at each email and move it by yourself, if you set up a rule. If an email comes in your 
inbox that needs a specific rule, instead of sitting in that email, it'll move to the other folder. This is how you add 
new folders, and move emails between one folder. 

Okay. If we are in Mail View, let's have a look into Home tab. Home tab have got all the options available for us, 
which we use quite often. Okay, you've got a new email, if you want to start with a new email, what happens? If I 
click on New Email here, please be aware, a new window opens up. This is entirely a new window. This window 
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has its own tabs. These tabs are different from these tabs. Why? They're different from these tabs, because this 
window is specifically designed for you to write a comprehensive email. You can set, if you go in the File part, it 
has its own options. If you go in the Message part, you can use Clipboard. Clipboard copies all the items from 
Microsoft products. They sit over here like a memory. You can use them. 

For example, this is something I copied earlier. If I want to paste it right here, I've just pasted it, and came straight 
away. Clipboard is pretty cool. These are your usual options of changing the font size, et cetera, attaching the 
files. Then you have got Insert option over here where you can attach files. If I want to attach a new file, I can 
attach it from here. 

If I want to include a table, if I want to create a table, I can go ahead and simply in the Insert tab, in the Tables 
group, I can click on the table. I can select the number of columns I want, and the number of rows I want. I can 
click on it. My table has been created. I can go ahead, and quickly design that table. Give it a nice bit of colour. 
Let's say something like this. Then I start writing on it. I can quickly create tables. That's why we've got a whole 
dedicated window. This dedicated window, again, it has its own functionality. It has its own Quick Access Toolbar. 
It's a really powerful window to go out and modify your messages, et cetera. 

One important feature I wanted to mention to you guys is, that if you send an email to somebody, while you're 
drafting the email, you can go to Options and you can ask the system to Request a Delivery Receipt. This is 
something similar to what you see in WhatsApp, at times. That if you send a message, you get one tick showing 
the message has gone, two ticks showing the message has been received and the blue tick, which this one would 
be, that you get a receipt saying, "Oh, the message is being read." You can go ahead, mark these, and send your 
message across. Please be aware that the person who gets the email would get aware of this. The person would 
be notified. 

Another important feature which is just right here in the Options tab is Delay Delivery. If you want an email to go 
out first thing in the morning, 9:00, spot on, you want to send an email, what you can do is you can craft an email 
earlier, you can craft an email, and then you specify from this part over here, Delivery options, do not deliver. You 
can say, "Do not deliver before," this specific time. It's being delivered at that time. Let's say 1:00 past 5:00, the 
email goes out. You can specify where the email is going to go. You've got the whole list over here of people you 
want to flick an email to. Right, cool. This is also a very good feature. Let's close this. 

Okay. Also, be aware that you've got the whole features of Insert. You have got your Pictures, Shapes, Icons, 
SmartArt if you use Word, et cetera. If you use SmartArt, you can quickly create a chart. You can quickly create a 
chart as a part of your email. You can modify the data. This is the Excel workbook, that little snippet of it, gets 
attached to it. You can modify the data. Let's say, you want to have it for two categories only. Of course, you can 
change the name, et cetera. You can create a chart quickly. You can design the chart really quickly, and send it 
across. Change the values, change it on the top, Yeah, it really is a powerful window for you to have pretty 
detailed email. 

Nope, I don't want to save this. 

Okay. That was the Home tab, and some of the functionalities of that. You've got Send/Receive. Yeah, you can 
look into it. You can go ahead and click on this, which is Refresh, receive folders and show progress, et cetera. 

Okay. I think we have done most of the important elements required by sending emails, essentially, with the 
Home tab. Let's have a look at the Calendar view. Because, of course, it's really important. 

If I click on the Calendar view, what happens is that, of course, these tabs, though it remains them, the 
functionalities keeps on changing. At the moment, if I want to move to a different Calendar, I can move quickly 
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between the Calendars. I have got a Calendar here. I can quickly move between the Calendars. I have got the 
months over here. I have got the months over here as well. I can change it from Day view to Work Week view. I 
can add Week view and Month view, et cetera. I can really go to term on creating, changing the views of the 
Calendar. 

Okay, cool. All right. Let's have a look at our Day view. All right. You can also see that you can have multiple times 
in your calendar. For example, if you're working with an organisation that is working in different time zones, what 
you can do is you can add additional time zones here. 

How do you do that? You can go to File. You can go to Options. Then you can go and click on Calendar. In 
Calendar, we can change the options of our Calendar. What options do we have? We can specify that, "Hey, I 
want my Calendar to start at 8:00, because I start work at 8:00." But if you start at let's say 10:00, then you can 
specify the start time and end time of your calendar. You can also specify the days you actually work. If you're 
taking Monday off, then you may want to say, "Hey, I want to untick the Monday. I want to make sure that I've 
got Tuesday, Wednesday, Thursday, Friday, and maybe Saturday." It depends. But if you keep Monday on, it'll 
show in your calendar. 

Then if you're sharing your calendar with somebody, they might book you in for a meeting on a day that you have 
agreed with your management that you're not working. Again, it can create a bit of confusion. You can go ahead 
and change this if you wish. 

Okay. Then if you scroll down, you can see that I have added one time zone, which is Auckland, Wellington, then 
I've added a time zone for Dhaka, and time zone for Bogota, Colombia. I've got three time zones. If I want to only 
show one time zone, I can untick both of them. Press OK. I would have only one time zone been shown over here. 
Okay, cool. Let me close this down. 

We have got only my Calendar showing not everybody. All right. If I want to start with a New Appointment, I can 
go ahead and click on New Appointment. Appointment is basically a way of blocking in your calendar. Now, I can 
specify as to what the title of appointment is, when the appointment starts, when the appointment finishes, 
where the appointment is. If it is all day, I could click on that. Then it'll block out the whole day. 

If that appointment needs to be done, let's say, once a week, and that is every Friday between, let's say, 2:00 to 
3:00, you can go and make it reoccurring. You can specify the start time, end time, duration, location, and then 
Reoccurrence pattern, you can have it on weekly basis, daily, monthly, and then reoccur every one week. Or you 
can have it alternate weeks. Let's say every three weeks, or every four weeks. I need to block out Friday, 3:00 to 
4:00. 

Then you can specify that, "Hey, my recurrence range should start from this week, and end by let's say, two years, 
three years or one year. You can specify by date. You can also specify it by number of occurrence. You can say, 
"Hey, stop after 10 occurrences." It's good to set these ones up if you are setting up appointments, where you 
end up inviting somebody, and it becomes a meeting. If I set this as an appointment, if I say, "Working on Report." 

Okay. I've added the location. It's been added already. If I want to invite somebody as a part of this appointment, 
see what happens. If I go ahead and say Invite, it quickly turns into a meeting. Now, appointment turns into a 
meeting. Then you can specify who you would like to become part of the meeting. Let's say I'm inviting this boss 
here. Some of you guys would have embedded with Teams. Or you may also have it with Zoom. At the moment, 
we're using Teams. As soon as I add Start a Meeting, it starts creating that Microsoft Teams meeting. Meeting ID 
and passcode, et cetera. I can specify what the message is all about, and send it across. It'll block out my day. 
That's one way of creating an appointment, and turning into a meeting, if you invite another person. Cool. 
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All right. Let's move to our next piece, which is going all the way down to tasks. This is pretty cool. What they do 
is, it allows you to create new tasks, things you have to do. For example, you're brainstorming, and the list of 
things, which a lot of people, write it on a piece of paper. What they can essentially do is to put them in a task. 
What is an advantage of putting them in as a task is because they can specify details about start date, end date. 

They can also assign tasks to somebody. For example, let's say, Creating a Demo video. We can specify the start 
date. We can say, "Oh, it's not been started." Priority is high. Completed none. Reminder, I can add details, blah, 
blah, blah to it. I can actually go ahead, become cheeky, and assign somebody to it. For example, I can assign this 
person. All right. Then I can send it through. That task would be created, and send across. 

You can see, the task has been created, and sent across. You can have a list of tasks over here. You can see what 
tasks are due today, tomorrow, next week, et cetera. That's one of the very basic way of creating tasks. 

You can also categorise your tasks from here, by going into category, blue category, green category, and you can 
specify what those categories are all about. Okay, good. Cool. You can put it as a high importance or a low 
importance from here. If you are in a message, on the mail, and you got an email of your boss asking you to do a 
certain task, you can convert that email into a task. You can go ahead, in the quick step, you can convert it into a 
task. You can save and close. Quickly convert your emails into tasks, and they'll show up in your Tasks. Cool. You 
can see, that's been converted into Task. 

Yeah. Mail view is where you see all the emails. On the left-hand side, you'll see the email addresses added to 
your email page. Then if you go down, you've got Calendar view. You can tweak your Calendar view. But the 
objective of having a Calendar view is to see how you are booked up for the rest of the year, and how many 
meetings you have. If you have been sent a meeting invite, and you accept that meeting, then you're suddenly 
wondering where that email went. It is actually sitting in your calendar. You can go to the date where you've 
accepted that email. It would show up there. Then you've got to-do list, which is your tasks. You can add your 
tasks over here and monitor them. 

Sometimes what you would encounter is that if you open up, and you'd see a view, which is very distorted, 
meaning that you'd see something like a Folder view minimised, you'll see something like this. You're like, "What 
shall I do? I can't see the folder here." You open it up, but as soon as you click somewhere it might go away. What 
you can do is just go in the View tab here. Then in the Layout Pane, this is where you can tweak your views. If I 
want to see the Folder Pane again, I can say, "I want to see it normal." You can see it's showing as normal. 

The next option is Reading Pane. Reading Pane is this piece in the middle. If I want to see it on the right-hand side, 
this is how it is. If I want to see it at the bottom, you can see, it went at the bottom, our messages went on the 
top. If I want to turn it off, which I wouldn't recommend, will be here. If I want to keep it on the right like before, 
you can see it from here. 

In the Layout, you have the to-do bar list as well. If you want to view your calendar at the same time while you 
are looking at your email, which is an excellent idea, you can click on your calendar. Your calendar would show up 
on the right-hand side as well. Then you can also see how you're busy here over the day. That means that would 
save you from clicking from Mail to Calendar. Because you have your calendar sitting in the Mail. 

If you go on the View, all the magic is happening in the View, and the Layout. If you want to have your Tasks, you 
can have your Tasks listed on the top. You have a very comprehensive, big screen with lot of information, which 
you can view at one glance. Okay, cool. 

That sums up our session for Microsoft Outlook. Feel free to ask questions. I'd request Alison, she can take over. 
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CCH Learning: 

Thank you very much, Waqar. Okay, we have had a couple of questions come through. But just a reminder to 
anyone else who wanted to pop a question through, please do so into that questions pane. Then we can add 
those to our Q&A. 

All right. In the meantime, I will quickly mention our upcoming webinars. Tomorrow, we're looking at Microsoft 
Teams with SharePoint and OneDrive. Then the Best of Microsoft PowerPoint. 6th of February, kicking off our 
Cyber Security Updates. Then looking at SME Loans. 

7 Feb, Q&A session with Aged Care. Then the start of our FBT session. This one on Salary Packaging. Jump on the 
CCH Learning website if you're after any of those details. 

All right, Waqar. I will get into these questions for you. First one is from Sandra. I can't see my Quick Access 
Toolbar. How do you get this displayed? I'm just going to hand the screen back to you. 

Waqar Awan: 

Yes, please. Thank you very much. Okay. The Quick Access Toolbar. Just bear with me for a second. Let me share 
my screen. Here we are. Okay, thank you very much. 

Okay. The Quick Access Toolbar, most of the time, it sits on the top over here. But it is a bit deceiving. What it 
does is sometimes it goes over here, like Hide Quick Access Toolbar. It goes away. What you can do is right-click 
and show that Quick Access Toolbar. It could be hidden. You can unhide the Quick Access Toolbar as well. Yeah, 
this is how you can see ... If you go into Options here, you can have the Quick Access Toolbar options from here as 
well. You can click on Show Quick Access Toolbar. 

If it's hidden, you practically can right-click, but nothing works out. The solution for that is just going in the File, 
going to good old Options, and then going to our Quick Access Toolbar tab here, and then selecting Show Quick 
Access Toolbar. Then we can also specify, "Hey, the position of the toolbar is above the ribbon." This is the ribbon. 
You want to see Quick Access Toolbar above the ribbon. If you want to have it below the ribbon, I don't know why 
would you want that, but you can have that as a below the ribbon, and see where the Quick Access Toolbar can 
go. Just hold on for a second. It is not showing. Yeah, Show Below the Ribbon. There you go. Below the ribbon 
would show right here. Above the ribbon would take it on the top left. Cool. Thank you. 

CCH Learning: 

Thank you, Waqar. Lai, apologies if I'm pronouncing that incorrectly. They've just asked, "Can you search for 
keywords in shared Calendars?" 

Waqar Awan: 

Can you search for keywords in shared Calendars? Yes, you can. If you have a shared Calendar, yes, you can go 
ahead, and search for keywords. But yeah, you can search it over here. It would search from this toolbar here. 

Shared Calendar is always tricky, because the thing is, the person who's going to be creating the shared Calendar, 
the search preference or the setting preference has been applied for the person who has actually created and 
shared it. That person has got the right to allow people to search things, et cetera. Most of the time, you can go 
ahead, and search it from here. Yeah. You can do it from there. Yeah. Cool. Thank you. 
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CCH Learning: 

Thank you, Waqar. Sam has asked, "How do you use the voting buttons?" 

Waqar Awan: 

How do you use the voting buttons? Okay. You guys are seeing my screen, which is great. Let's go to Home here. 
We are going to go, and open up a new thing over here. Are you referring to the Use Voting Buttons? Options? 
Voting Button is an old school way of just asking people about opinions. What you can do is just Use Voting 
Buttons from here. You've got options here, which is Approve/Reject. 

For example, if you are proposing, "Hey, we should have a staff dinner." Then you can put Approve/Reject button. 
You can add that to the message. Then if you send the message across, that button would show up. At the 
moment, I don't have the message. It gives you, "You've added a button." When it goes, the recipients would be 
able to see it from there. They respond back. 

What I really like is this Poll one right here. If you click on the Poll, it works with Microsoft Forms, then you can 
use it. It's more interactive, and it's more dynamic. "Staff dinner," question mark. You can specify the options. 
Monday, Tuesday. Then you can specify multiple answers over here. Next, add to the email. Then you, of course, 
need to log. You'll have your accounts logged in as well, the right account. Then everything works fine from there. 
It gets added up to your email. Then you can send that across. Okay, cool. Thank you. 

CCH Learning: 

Thanks, Waqar. Sam just mentioned, he tried it with the yes or no option, but it's not working on his end. 

Waqar Awan: 

Yeah. This one over here, Yes/No with Use Voting Buttons, to be honest, I haven't used this very recently. I have 
been using Poll because it's giving me a good option there. What you can do is try to restart your Outlook. It is on 
the way out. Use Voting Buttons, like I mentioned, it's a legacy sort of a function. Maybe there's something to do 
with restarting your Outlook. It does work at times. 

Yeah. Give it a go, and see if that works. Send that email to somebody. They may see the options there on their 
end as a voting option. Right. Cool. 

CCH Learning: 

Thank you, Waqar. Question from Denise. "On some tabs in New Message, the tabs are shaded out. Is this done 
by my organisation?" 

Waqar Awan: 

Oh no, possibly. New Messages, okay, this is the one. Some of the tabs have been shaded out. I am yet to see if 
that is possible. That these tabs could be shaded out. But if they have been shaded out, you've got two things you 
can do. You can restart your system. If this is something extraordinary, you've never seen them shaded out 
before, just restart your system. It's always been like this. Then, of course, there's a possibility that you can't use 
those options or tabs. 

CCH Learning: 
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Thank you, Waqar. Kate's just written in, "I guess, on this topic, if you wanted to have the BCC appear in your 
sending options there, how would you do that?" 

Waqar Awan: 

Yeah. Oh yes, good. Good question. Good question. It should be BCC. It was in the Options part. It's a very good 
question. I was actually looking at it here, Show Field. It is in Options tab. It is in Show Field, and then BCC would 
show up, if you want to send BCCs. Cool. Awesome. 

CCH Learning: 

Perfect. Thank you, Waqar. Luke has asked, "What is the name of the feature that replies to incoming emails 
while you are out of the office?" 

Waqar Awan: 

That is called as Automatic Replies. If you go in the File, you can go to Automatic Replies, which is also called as 
Out of Office, but that's probably not the case. You might be in the office, but you just don't want to reply to the 
email. But the feature is called Automatic Replies. 

CCH Learning: 

Perfect. Thank you, Waqar. All right. That looks to be all the questions that have come through for today. I'll just 
close off the session. If any others pop up, we can certainly slot those in for you. I'll just go through our next 
steps. 

Please take a moment to complete the Feedback Survey. It will pop up at the end of the session. Shortly after the 
session today, you will receive an email letting you know when the e-learning recording is ready. There will also 
be a verbatim transcript, CPD certificate, and of course, the PowerPoint presentation. 

Thank you very much to Waqar for the session today. Thank you to everyone in the audience. We hope to see you 
back on online for another CCH Learning webinar very soon. 

 

 


